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Preface 
 
The following tutorial is designed to be used by advanced GIS students within the 
framework of a remote sensing class or raster GIS class with a strong remote 
sensing component.  ArcGIS 10, any level, and the Spatial Analyst Extension are 
required to use this tutorial.  Students should be proficient in the basic functions 
of ArcGIS 10 including creating a new project and geodatabase, setting up a 
project workspace, adding data, adding and using the dockable windows, and 
using ArcGIS dropdown and menu tabs.  The tutorial utilizes most of the 
functionality of the Image Analysis window.  The tutorial does not, however, 
explain each function in detail.  This is an opportunity for the student to become 
familiar with the excellent “Help” resources available in ArcGIS and each section 
contains path references to additional information ( 
http://resources.arcgis.com/content/web-based-help ). 
 
Each Exercise begins with a brief statement of the purpose or concept of the 
Exercise.  When needed, the tools and functions may also be introduced.  Start 
ArcMap indicates the point at which the “hands on” instructions begin.  The 
operation of the tools and functions is discussed as part of the “hands on” 
directions.  Since this tutorial is intended to supplement and compliment a class 
focused on remote sensing, basic remote sensing concepts and discussions of 
sensors, data acquisition, data formats, and other aspects of remote sensing are 
not provided.  Remote sensing online tutorials are available from:  
 
NASA http://rst.gsfc.nasa.gov/ 
  
The Canadian Centre for Remote Sensing 
http://www.ccrs.nrcan.gc.ca/resource/tutor/fundam/index_e.php 
 
Experimentation is key to understanding any new tool.  Please use this tutorial as 
an introduction and guide and then experiment with the included data set or, 
more importantly, acquire your own data and really enhance your experience.  
An outstanding archive of remote sensing and GIS Learning Units is available 
through the Integrated Geospatial Education & Technology Training (iGETT) site 
hosted by Del Mar College: 
 
http://www.delmar.edu/igett/LearningUnits.html 
 
Special thanks to the students of GISC 1491 and GISC 2411 at CyFair College 
for working through the exercises, finding errors, and suggesting improvements.  
Ann Johnson, Associate Director, GeoTech Center provided encouragement, 
comments, and suggestions that were critical to a useful document. 
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Introduction 
 
Lawrie Jordan, Director of Imagery for Esri recently stated that “GIS users are the 
largest collection of imagery users in the world.”  The combination of unique view 
(synoptic and multi-spectral), extractable information, timely acquisition, and 
extensive archive make imagery an important component of GIS.  Formerly, 
image analysis (IA) and GIS were largely separate disciplines and separate 
software.  As the bilateral integration occurs, it is logical that this convergence 
should be reflected in software development.  Esri has addressed this need by 
incorporating IA tools in the ArcGIS 10 release.  If you discover that you need 
more image data types and more sophisticated processing for your projects, IA 
tools are available as 3rd party toolboxes (ENVI 4.8) and extensions for ArcGIS 
and as separate IA software systems. 
 
In this tutorial, you will explore most of the important functions in the Image 
Analysis window using images and data from the Houston, TX region.  The 
Image Classification toolbar is only available with a Spatial Analyst license but it 
is important for extracting information from the image data.  Several examples of 
classification will be given in this tutorial.  References are made to ArcGIS Help 
throughout this tutorial.  If you want to explore ArcGIS help topics using the Web, 
go to http://resources.arcgis.com/content/web-based-help.  You are strongly 
encouraged to read through the entire Exercise before you start each one. 
 
After completing the exercises in this tutorial, you will be able to locate and use 
the ArcMap and Image Analysis tools you need for basic preparation, 
enhancement, and analysis of aerial and satellite images.   
 
Image Sources 
 
Please refer to the ArcGIS Help: Resource Center>Professional Library>Data 
Management>Geographic data types>Rasters and images>Supported raster 
data for detailed information on supported image file formats.    The list is 
extensive.  Specialized Image Analysis software may be needed to load and 
convert data from other sources.  Important Note: You cannot use raster 
catalog layers in the Image Analysis window. 
 
Image access falls into three types: local, dynamic, and static.  Local access 
refers to imagery available on a local disk or server.  It is also called “direct 
access”.  Imagery you select and download from the Web or media will be local.  
Dynamic service refers to images that are delivered by a remote service that 
assembles an image at your request and serves it back to you.  You may be able 
to exercise some control over the image production in this environment.  Esri 
image services are examples of dynamic service.  Static services provide 
predefined images or tiles.  ArcGIS.com, Bing (Microsoft) Maps, and Google 
distribute large volumes of static images over the Web.  You will use local access 
for the images and data used in these exercises. 
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Exercise 1 – Starting Image Anlysis 
 
IAtutorial/Houston_TM.tif, the image we will use for this exercise, is a spatial 
and spectral subset of a full Landsat TM scene acquired 9/20/1999.  The subset 
contains 6 spectral channels, more commonly referred to as bands, of Landsat 
data ranging from the visible (band 1 = blue, band 2 = green, and band 3 = red) 
to the reflected infrared (bands 4, 5, & 7).  Landsat band 6, a thermal band, is not 
used in this tutorial and so Landsat band 7 becomes band 6 in the ArcGIS list.  
Landsat TM also includes a panchromatic band (band 8) with 15 meter spatial 
resolution.  We will use the panchromatic band in Exercise 3 to create a pan-
sharpened image. 
 
This would be an excellent time to review the properties of images and the 
characteristics of Landsat TM sensors.  The following links to The Canadian 
Centre for Remote Sensing tutorial are a good place to start. 
 
http://www.ccrs.nrcan.gc.ca/resource/tutor/fundam/chapter1/07_e.php 
 
http://www.ccrs.nrcan.gc.ca/resource/tutor/fundam/chapter2/12_e.php 
 
 
Start ArcMap.  You can use image analysis tools in any level (ArcView, Editor, 
or ArcInfo ) of ArcGIS 10 Desktop.  Open a new map document.  Add the 
Houston_TM.tif image with the Add Data button by navigating to the IAtutorial 
directory and selecting the designated file.  The image will appear in the ArcMap 
Table of Contents.  Remember that band 6 in the ArcGIS list is TM band 7. 
 
Image Analysis for ArcGIS is activated by clicking on the Image Analysis window 
in the Windows dropdown menu on the Main menu toolbar in ArcMap.  
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You can dock the IA window in ArcGIS 10, which is often the most convenient 
way to use it.   
 

 
 
 
Open the Image Analysis Options at the top of the window.  You will not change 
these now but as you become more familiar with the functions in Image Analysis, 
you will want to alter them for specific image types or projects.  
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The Image Analysis window will show the Houston_TM.tif in the layer list at the 
top of the window. 
   

 
 
Right click on the image and note that there are three options: Accelerate, 
Remove, and Properties.  Click Properties and this will bring up the Layer 
Properties menu just as it would if you right clicked and selected the Properties in 
the Table of Contents. 
 
Examine each of the tabs: General, Source, Extent, Display, and Symbology.   
This is the time to make note of critical parameters from the Source tab for future 
reference in a project notebook or for producing metadata.  The information 
includes columns and rows, cell size, pixel depth, extent, spatial reference, and 
statistics.  You can copy the entire list or single rows to a text document but it will 
include all the HTML code.  It is often easier to copy the information you want 
from the text into a pre-formatted spread sheet.  
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The Extent tab has similar information to the Source tab except for the listing of 
current extent, if zoomed in, and extent of data frame.  The Display tab has 
options for displaying and manipulating the data but you will use the tools in the 
IA window at this time. 
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The Symbology tab allows you to select the assignment of bands to the display 
color channels, display of background value, stretch options, view image 
statistics using several sampling options, and pan-sharpening parameters (to be 
discussed in the Processing panel section of this tutorial).  
 

 
 
Remember that band combinations, band color assignments, and image 
enhancements can have a great impact on scene visualization and interpretation.  
You can review the concepts and principles of image processing at: 
 
http://rst.gsfc.nasa.gov/Sect1/Sect1_1.html 
 
http://www.ccrs.nrcan.gc.ca/resource/tutor/fundam/chapter2/12_e.php 
 
http://www.ccrs.nrcan.gc.ca/resource/tutor/fundam/chapter4/05_e.php 
 
Again, you will use the tools in the IA window for most of these functions.  
However, the default band assignments for the Houston_TM.tif image have 
produced a very poor display; almost monochromatic.  First, be sure RGB 
Composite is selected as the Show option to display all 3 bands.  Reverse the 
order of the bands to R = 3, G = 2, and B = 1.  This will produce a true color band 
combination with red band 3 in the red channel.  Now try an R = 6 (actually TM 
band 7), G = 4, and B = 2 combination.  Vegetation appears green and water a 
dark blue.  The urban areas are magenta but that is often more acceptable to the 
viewer than red or blue vegetation.  Use the 6, 4, 2 band combination for the 
following exercise. 
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You can change the default order of band display in the Main menu> 
Customize>ArcMap Options>Raster tab.  This is convenient for satellite images 
but may have an undesired affect on other picture types. 
 

 
 
Prepare a layout to contrast the “true color” R=3, G=2, B=1 image with the R = 6 
( 7), G = 4, and B = 2 combination.  Be sure to include the key elements of a map 
in your illustration; title, scale, and brief text identifying the images.  Export the 
layout by selecting the “File” dropdown menu and selecting “Export Map”.  
Choose “TIFF” format, 150 dpi, and an appropriate file name (one that does not 
conflict with any of your other .TIF files) and location.  The TIFF format is 
recommended for text clarity.  The JPEG option creates artifacts around text that 
degrade appearance.  Place the exported map in a Word (compatibility) 
document by going to Insert>Picture>From File and selecting your .TIF file.  
Briefly discuss the application and visualization characteristics of both 
combinations.  Turn in the document for Exercise 1 credit. 
 
This concludes Exercise 1.  If you are continuing on to Exercise 2, where you will 
work with the Display panel, just continue to follow the instructions.  If you are 
stopping at this point, save this map document as AITutorial1.mxd.
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Exercise 2 – Enhancing the image with the Layer Properties and Image 
Analysis window: Display panel 
 
There are many display options in the IA window.  Images in raw form are rarely 
optimal for viewing and interpreting.  By changing the distribution of pixel values 
in the image histogram or “stretching” the image, the brightness and contrast of 
the image can be significantly improved.   
 
Start ArcMap  If you are not continuing from Exercise 1, open AITutorial1.mxd.  
Open the image properties and examine the stretches for each band by clicking 
on the Histograms button in the Stretch portion of the menu. 
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The ArcGIS default stretch uses 2 standard deviations calculated from a 
statistical analysis of pixel value frequency distribution.  Note that the stretches 
are different for each band.  To see what the image would look like without 
manipulation, set the stretch type to “none” and apply.  This would be a difficult 
image to examine and interpret.  Apply the “Histogram Equalize”, “Minimum-
Maximum”, and “Percent Clip” stretches with their default settings and note the 
differences.  Change the default min: and max: settings of 2(%) in “Percent Clip” 
to 10 and note the difference.  There are also more interactive methods of 
histogram stretch that are not used in this tutorial. 
 
It is very important to remember that you do not want to alter the original 
pixel values of an image permanently if you intend to subsequently perform 
classifications or other processes involving band calculations.  Keep your 
original file safe. 
 
The “Display” panel offers many tools to quickly improve the appearance of the 
image. 
 

    
 

1

2

3

4

5

1 Contrast Slider  

2 Brightness Slider 

3 Transparency Slider 

4 Gamma Slider 

5 DRA (Dynamic Range Adjustment)

 11



Please refer to the ArcGIS Help: Resource Center>Professional Library>Data 
Management>Geographic data types>Rasters and images>Displaying raster 
data and subtopic >Options for improving the display of raster data for detailed 
information on the Display panel of the Image Analysis window and the tools 
available. 
 
Experiment with the sliders to quickly enhance an image for display and to use 
for data interpretation and extraction such as heads-up digitizing. 
 
The operations of the gamma slider, DRA button and Background button require 
some explanation.  The gamma slider controls the brightness of the middle 
values without affecting the values at the extreme ends of range.  The gamma 
slider can also affect the ratios of red, green, and blue.  Small variations in the 
gamma values can have large effects on the image.  The Dynamic Range 
Adjustment button adjusts the stretch based only on statistics of the data 
contained within the data frame.  Zoom in to a scale of 1;50,000, check the DRA 
box, and observe the changes.  The Background button sets the background 
value to 0 and makes it transparent.   This is very useful when a transformed 
layer is surrounded by “no data” in black and you want to see the image beneath. 
 
The selection of the resampling method is important because it affects the 
usability of the image for classification and band calculations.  Nearest neighbor 
is the only method that does not involve alteration of the pixel value.  The cubic 
convolution method results in the sharpest image with minimized “jaggies” in 
straight lines.  If you are still at the 1:50,000 scale (if not, zoom in), go to the 
“Resample” drop-down and switch from “Nearest” to “Cubic” and note the 
differences in appearance. 
 
The One-to-One button or Zoom to Raster Resolution displays the image at 
its optimal resolution.  The Swipe and Flicker tools are used to 
view and compare two overlapping images or raster layers.  You will use these 
tools later to help interpret Exercise results.  Select the layer you want to Swipe 
in the Image Analysis Window and be sure it is on top. 
 
You have now enhanced the image to improve its usability.  Create a layout with 
your best enhancement of the Houston_TM.tif image, export it, and place it in a 
Word (compatibility) document.  Describe the choices you made and parameters 
you set to achieve the enhanced image.  Turn in the document for Exercise 2 
credit.   
 
Save your enhanced image as Houston_TMenh1.tif and the map document as 
AITutorial2.mxd.  You can save your image by right-clicking on the layer in the 
Table of Contents and using data>data export.  You can also use the Export  
button in the IA Processing panel.   
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This is an excellent time to organize your data and to plan for future exercises.  
Depending upon how you have been using ArcGIS for previous projects, you 
may be saving to folders or a geodatabase.  ArcGIS has a default geodatabase 
located in C:\ Documents and Settings\(your user name)\My 
Documents\ArcGIS\Default.gdb.  (NOTE: If you exported data without checking 
the location and could not find it, this is a good place to look!)  It is NOT the 
location for the temporary results of operations in Image Analysis.  They are 
located in C:\ Documents and Settings\(your user name)\Local Settings\Temp.  
Do not delete or alter these files because they are your temporary results.  
Delete them from inside your ArcGIS map document.  For these exercises, it is 
recommended that you create a new file geodatabase and name it IAtutroials.  
Set this as your default geodatabase by going to the File>Map Document 
Properties and making the changes as illustrated. 
   

 

Within the geodatabase, 
you may want to set up 
feature datasets for certain 
sections of the Exercises.  
Remember, however, that 
feature datasets must be in 
the same datum, projection, 
and coordinate system.  
The data sets within this 
tutorial are mixed Decimal 
Degrees, UTM, Texas State 
Plane S Central, etc. 

 
 
Remember, the AI tools operate on the layer(s) selected in the list.  Avoid 
unintended consequences by selecting the target layer carefully.
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Exercise 3 – The Image Analysis window: Processing panel 
 
The Image Analysis window: Processing panel offers a suite of basic tools 
for performing processing and analysis techniques to single or multiple, 
depending upon the operation, images and raster data sets.  The tools 
operate on one or more layers selected in the Image Analysis window layer 
list.  One key feature of the processing in this section is that it results in 
the creation of temporary layers.  The results must be exported to become 
a permanent file.  The advantage to this approach is that the user does not 
have to manage a vast collection of intermediate files while arriving at an 
optimal result.   
 
Please refer to the ArcGIS Help: Resource Center>Professional Library>Data 
Management>Geographic data types>Rasters and images>Processing and 
analyzing raster data and subtopic >Analysis tools on the Image Analysis window 
for detailed information on the Processing panel of the Image Analysis window 
and the tools available.  Resource Center>Professional Library>Data 
Management>Geographic data types>Rasters and images>Fundamentals of 
raster data provides detailed information on the raster functions called by these 
buttons. 
 

 

1
2

3

4

 
The top row (1) of buttons holds the tools (from left to right): Clip, Mask, 
Composite Bands, NDVI, Colormap to RGB, Difference, Pan-Sharpen, 
Orthorectify, and Export.  Remember, the options for setting the tool parameters 
are found in the upper left of the Image Analysis window (see page 5). 
 
Row 2 holds button for creating a Shaded Relief of the selected layer and 
symbolizing the resulting layer with various ramps. 
 
Row 3 holds the Mosaic button and a drop-down menu for handling the 
overlapping areas of raster layers selected in the layer list. 
 
Row 4 holds the Filter button and a drop-down menu of preconfigured filter 
choices.  Please refer to the ArcGIS Help: Resource Center>Professional 
Library>Data Management>Geographic data types>Rasters and 
images>Building and managing a raster database>Mosaic datasets>Working 
with functions “Convolution function for detailed information on and examples of 
convolution filter types. 
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You will now apply some of these tools to produce useful enhancements and 
analyses to your Houston project. 
 
Start ArcMap and open the Image Analysis window.  Open a new map 
document.  Add the Houston_TM250.tif image with the Add Data button by 
navigating to the IAtutorial directory and selecting the designated file.  This is a 
larger spatial subset of the 1999 Landsat TM image used in the previous 
Exercises. 
 
Efficient image analysis necessitates image subsetting to use only the area that 

is required by the project.  The Clip button  will subset the image to the data 
view extent or to the extent of overlap with a feature or graphic.  You will want to 
isolate features in the area of Houston International Airport in some future 
project.  Draw a polygon as shown around the airport.  This is done by activating 
the Draw toolbar.  
   

 
 
From the toolbar, select the rectangle tool and enclose the area described above.  
Change the polygon graphic fill to “no color” with a red outline.  With the polygon 
selected and the Houston_TM250 image selected in the image list, click the 
Clip button in the Processing panel of the Image Analysis window.   
 

 
 
You should immediately see a Clip_Houston_TM250.tif image in the layer 
(image) list and the Table of Contents.  One potential problem that occurs with 
the Clip button is that it will clip partial pixels.  This can cause pixel alignment 
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problems in subsequent operations.  Remember, this is a temporary image and it 
must be exported using the Export button to become a permanent file.  Select the 
Clip image in the image list and click the Export button.  The Export Raster Data 
window will open.  Review the parameters in the window and save the file as 
HouAirport_TM.tif.  You can subset the available bands by using the “Make 
Raster Layer” tool in the Data Management Tools>Layers and Table Views. 
 

The Mask button  is used to create a masked or hidden area or areas within a 
data set.  The masked area values are converted to “NoData”.  A graphic or a 
polygon feature within a feature class layer can be used to designate the areas.  
Masks are used to exclude data from an analysis.  One common use of Mask in 
IA is to eliminate cloud covered areas so that they will not affect the statistics of a 
classification.  Unsupervised classifications, in particular, can be heavily biased 
by cloud signatures.  For simplicity, assume that Homeland Security has 
designated the airport as an area that must not be displayed on a map or 
represented in an image file.  Use the same polygon you used to sub sample the 
Houston_TM250.tif image to create a mask of the airport.  Click the Mask button 
and you should immediately see a Mask_Houston_TM250.tif image in the 
image list and the Table of Contents.  Turn off all other layers. 
 

 
 
Use the Identify tool to view the values inside the masked area.  The values 
should be “NoData” for all 3 bands.  Turn on the HouAirport_TM.tif  image and 
see that it fills the NoData area. 
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The Composite Bands button   is very important because it allows you to 
combine single image bands or raster layers into one multi-band raster layer.  A 
significant component of the available image archives is imagery in single band 
format, usually as (geo)TIFF files.  To process data as multi-band sets for 
functions such as classification, the bands must be combined into a single raster 
layer.  As part of your analysis of the Houston area, you might want an image 
that is more current than 1999.  The last Landsat 7 data that was not affected by 
the scan line corrector (SLC) fault was prior to April, 2003.  (Research the SLC 
issue if you are not familiar with it; it impacts a lot of imagery that you might 
consider using in projects.)  The available scene is in single band .TIF format.  
You will need to composite the bands to use the data in future analyses.  The 
IAtutorial\Houston_03 directory contains 4 files, Hou03_1 through Hou03_4, 
which are bands 1 through 4 of a full Landsat TM scene for path 26 row 39 from 
1/18,/2003.  The directory also contains metadata for the image.  This scene 
contains the same areas subset for the 1999 Landsat images.  You will 
composite the bands by adding them to a new ArcMap document.  Add the 
separate bands, Hou03_1 through Hou03_4.  Be sure they appear in numerical 
order in the Table of Contents and Image Analysis window.  Select all 4 bands in 
the IA window and click the Composite Bands button.  You should immediately 
see a Composite_ Hou03_1.tif layer in the Table of Contents and IA window 
list.  Export the raster layer as Hou03_4B.  If you are using a geodatabase and 
the “Format” entry in the Export Raster Data window is not “File Geodatabase” 
(grayed out), you may have to reset the “Location” to set the geodatabase 
location, even if it has not changed.   
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Remember to “stretch” or use the Display panel options to enhance your 
Hou03_4B composite image.  The final product should look something like the 
example below.  Now that you have scenes with a temporal difference, think 
about how you could compare them.  What might a 2003 NDVI show (coming 
next)? 
 

 
 

The normalized difference vegetation index or NDVI  button is used to perform 
image algebra on the red (band 3 for Landsat TM) and near infrared (band 4 for 
Landsat TM) bands of an image to produce a new single band layer that shows 
“greenness” or relative biomass.  The brighter (higher) value indicates a higher 
percentage of vegetation, healthier vegetation, or plant species differences.  The 
formula for the calculation is: NDVI = (IR – R)/(IR + R).  Landsat MSS uses bands 
2, 4; SPOT XS 2, 3; and NOAA AVHRR 1, 2 for this transformation.  Consult the 
Web for sensor information on other combinations.  Since the NDVI is a ratio, the 
processing will minimize shadow effects.  You will perform an NDVI analysis of 
the Houston_TM250.tif image.  First, use the Options button (see page 5, this 
tutorial) to confirm that the default bands selected are 3 for red and 4 for IR.  
Select the image in the in the layer list and the NDVI button will activate if it is not 
already.  Click the NDVI button and you should immediately see an 
NDVI_Houston_TM250.tif image in the layer list and the Table of Contents and 
layer list. 
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Image Analyst will apply a Colormap to the results.  The greener colors indicate 
greater vegetation mass (or vegetation health or species) and redder colors 
indicate less vegetation.  If you want to examine an image that will give you a 
better understanding of the relative pixel values, make a copy of the layer in the 
Table of Contents and change the color ramp to gray-scale.  Carefully examine 
the image.  Zoom in on an area containing a golf course east of the airport and 
examine the signatures.  Use the swipe tool by selecting the NDVI image in the 
layer list and swiping over the TM layer.  In addition to mapping vegetation, 
would this image be useful for identifying urban infrastructure and impervious 
surface? 
 

 Golf course 
 
What else, besides urban infrastructure and impervious surface, has a low NDVI 
signature?  What masks would allow you to more easily extract an “Urban” layer 
without including undesired features?  Answer these questions in a Word 
document and include useful images and illustrations. 
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The Difference button   can be used to compare classified images or any other 
single band raster file type.  The difference or change detection uses the 
arithmetic minus function to calculate the difference between two raster layers. 
 

  
tree cover loss and the positive numbers are tree cover gain.  The values range 
from 8 to -8 and are the class values assigned to the original color map.  

The lowest selected layer in the layer 
list is subtracted from the upper 
selected layer. 
 
At the present time, the Difference 
button is producing results that are 
difficult to use.  Esri has registered 
an official “bug”.  Do not use this 
tool until the problem is corrected.  
 
If you want to see what the Difference 
button is supposed to do, add the 
hous84clip.img and hous99clip.img 
layers to the layer list with the “99” 
image on top.  These two files are 
classifications of percentage tree cover 
for Houston in 1999 and 1984 (see 
TOC symbology below).  Use 
ArcToolbox>Spatial Analyst 
Tools>Math>Minus tool with the “99” 
layer as Input Raster value 1 to see 
the changes in tree cover between the 
two years.  The minus numbers equal  

 
Therefore, a + 8 indicates a 90 to 100% 
increase in tree cover between the two years, a 
0 equals no change, and a - 8 indicates a 90 to 
100% tree loss.  This is a very significant result 
for the Houston area.  Can you equate tree loss 
or gain to processes associated with the 
development of the Houston region?  For 
emphasis, all tree loss is shown in red and all 
tree gain is shown in green in the presentation 
below.  No change is in white.  For reference, 
note the location of Lake Houston, the major 
highways, and Houston (Bush) Intercontinental 
Airport.  
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The Pan-Sharpen tool is very useful for enhancing the spatial resolution of 
project images.  Please see Resource Center>Professional Library>Data 
Management>Geographic data types>Rasters and images>Processing and 
analyzing raster data>Panchromatic sharpening for detailed information on 
panchromatic sharpening in ArcGIS 10.  The tool uses a higher-resolution 
panchromatic layer such as the Landsat TM Pan band (Band 8, 15 m) to 
combine with multi-spectral bands (TM 1-5 & 7, 28.5 m).  The resulting image, in 
the case of Landsat TM, is a multi-spectral image with 15 m spatial resolution.  
Pan-sharpening is available from both the Symbology tab and the button in the 

Image Analysis: Processing panel.  You will use the Pan-sharpen button  in 
Image Analysis.  Add the Houston_Pan250.tif image to the project.  Adjust the 
layer order the Table of Contents and layer list so that the Houston_TM250.tif is 
above the Houston_Pan250.tif.   
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Open the Image Analysis Options and examine the available options for pan-
sharpening.  You will use the Esri type for this exercise but you should read 
about and experiment with the other color transformation options.  Note that the 
options will also adjust the near-infrared band which can be a significant 
advantage. 
 

 
 
Click the Pan-sharpen button and the layer Pansharp_Houston_TM250.tif will 
appear at the top of the TOC and layer list.  You will now use several of the 
image analysis display tools to enhance the pan-sharpened image and compare 
the results with the HouAirport_TM.tif image created earlier.  First, enhance the 
Pansharp_Houston_TM250.tif image.  Try the Esri default of a 2 standard 
deviation stretch on the RGB composite.  You will probably see a request to 
calculate statistics.  Click “yes” IA will need image statistics to apply 
enhancements.  
 

 
 
 When you are satisfied with this enhancement, enhance the HouAirport_TM.tif 
image.  Next, use the One-to-One button to compare the resolution of both 
images.  Note the One-to-One scales for the two images and record them.  Use 
the Swipe tool (remember to select the layer to be swiped) to examine the 
differences between the images at the pan-sharpened scale and when zoomed-
in to a specific area.  Export images from both layers and put them in a Word 
document with comments on your results.  Be sure to include the scale 
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observations.  You will use the pan-sharpened image in the next step to examine 
the results of convolution filtering. 
 
You will now further spatially enhance your pan-sharpened image by applying a 
filter. 
 

 
 

Filters can produce many different effects such as sharpening, blurring, non-
directional and directional edge detection, reducing “noise” (such as the speckle 
in radar data), and generalization.  Convolution filters perform calculations on 
pixel values based on different weightings of a matrix of pixels called kernels.  A 
typical kernel is 3 x 3 pixels but kernel sizes can vary greatly depending on the 
results needed.  However, remember that filtering alters the pixel values.  The 
altered values may require re-stretching to achieve the best display.  Filtered 
images may not be suitable for classification.  You will now use the filter option to 
enhance the Pansharp_Houston_TM250.tif.  Make sure this layer is selected in 
the layer list.  Examine the options in the drop-down menu of filter options.  Refer 
to convolution filter type descriptions in the Help documentation (see the “Row 4” 
description on page 14 for the Resource Center help and information path).  
Select the “sharpen” filter and click the button to apply.  Apply a stretch to the 
resulting Filter_Pansharp1_Houston_TM250.tif image.  Now apply the same 
filter again to the filtered image (Filter_Filter_Pansharp1_Houston_TM250.tif).  
Does filtering always enhance the image?  Describe and illustrate the results in 
the document you prepared for pan-sharpening.  
 
The Mosaic button gives you an opportunity to look 
at a different data set.  The Mosaic button creates a new layer that combines 
selected raster layers in the layer list.  For this function, you will use two digital 
elevation datasets extracted from the USGS Seamless Web site.  HouDEM1 
(north) and HouDEM2 (south) were created from a single request to the USGS 
site.  Because of file size limitations, the request was split into two files dividing 
the area into north and south data sets.  The source data is LIDAR that was 
flown after tropical storm Allison.  It is a high resolution data set that has a ~3m 
spatial resolution and ~0.5 meter vertical accuracy.  The data set has been 
processed to “bare ground” by the removal of infrastructure and vegetation.  You 
need to combine the two files to facilitate processing and display. 
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You will need to invert the ramp to make the low elevations blue.  Experiment 
with different stretches to improve appearance. 

Add the two layers, HouDEM1 and 
HouDEM2 to a project.  You can continue 
with your existing project (map document) or 
create a new one.  Begin by opening the 
layer Properties and examining the Source 
information.  Note the key parameters such 
as file format, cell size, bit depth, and spatial 
reference.  The two layers will display with 
different gray scales because the range of 
elevations is different for each.  To combine 
the layers, you need to choose a method in 
the dropdown menu.  The two layers only 
overlap by one pixel and the values of those 
pixels are identical so you do not have to be 
concerned about the method of handling the 
overlap.  Choose the “First” option to use the 
layer that is first in the layer list.  In the 
illustration to the left, HouDEM1 will be used 
to supply the overlap values.  Click the 
Mosaic button and Mosaic_HouDEM1 will 
be created.  A more useful display can be 
created by applying a stretch and a ramp.  
Try a 2 Standard deviation stretch and the 
“precipitation” dark orange to blue ramp.   
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The example above is a starting point resulting from the parameters suggested. 
Experiment with other stretches and ramps.  Insert a map with the best results of 
your experimentation into a Word document and describe your procedure. 
 
Now that you have a DEM mosaic, you can create a shaded relief from the 
Mosaic_HouDEM1 layer.  First, examine the Hillshade tab options in the IA 
window.  Use the default settings for the initial processing.  Be sure the correct  
 

layer is selected in the 
Layers list.  Create the 
shaded relief using the 
Shaded Relief button. 
 

 
You can often improve the 
display of the data by 
selecting the new layer 
and changing the color 
ramp using the drop-down 
arrow in the Processing 
section. 
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You can change the Hillshade illumination properties on the fly by right clicking 
on the layer name and selecting the properties option.  In the Layer Properties 
  
 

 
 
 
window, select the Functions tab.  Double click the Shaded Relief function and 
the Raster Function Properties dialog box will allow you to make adjustments to 
the properties.  Changes will be applied on the fly but you must click “Apply” to 
implement the change.  Be patient.  On large data sets, the change will not be 
instantaneous.  Perform one more visualization operation.  Change the ramp of 
your shaded relief to gray scale.  To do this, you will need to go to the Properties 
of the layer, set the Show to “Stretched” from “RGB Composite” and use the 
default gray scale ramp.  Adjust the layer list so that 
Filter_Pansharp1_Houston_TM250.tif is above the Shaded Relief.  Change the 
display of this layer to 50% transparency and examine the results.  On some 
displays a 30% value gives better results.  Your result should look something like 
the screen capture below. 
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Add the results of this analysis to the Word document you began for the mosaic 
creation.  Describe the options you chose and the results.  Include map 
examples to illustrate your observations. 
 
Turn in all the documents requested for Exercise 3 credit. 
 
You have now completed Exercise 3.  The Orthorectify button was not used in 
these exercises.  This is a specialized application that is not usually included in 
basic analyses. 
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Exercise 4 – Classification with the Image Classification Toolbar 
 
Classification is a key procedure for creating information from data.  
Classification in image analysis is somewhat different from classification in GIS.  
In a GIS, you create classes or groups of features through statistical analysis of 
the attributes.  The geometry and attributes of the features are already known.  
Image analysis classification identifies pixels with similar spectral signatures 
through statistical analysis of multi-band images.  Groups of pixels with similar 
spectral signatures can be identified as features based on their geometric 
relationships and the knowledge and interpretive skills of the analyst.  Image 
classification is a very computationally intensive process which is why you 
spatially and spectrally subset your image data.  Below is an example of an 
information extraction by classification for the Houston International Airport.  The 
classes in this example are Dry Grass in yellow, Pavement and Rooftop in gray 
and magenta, Tree Canopy in light green, and Healthy Grass in dark green. 
 

 
 
Image classification is divided into two main types; supervised and unsupervised.  
They both rely on statistical techniques for the assignment of pixels to classes.  
However, supervised classification utilizes class information input by the analyst 
before statistical analysis and classification of the image.  The analyst selects 
training samples or regions of interest (ROIs).  Properly selected training 
samples contain pixels that represent the spectral characteristics of only the 
feature or feature class to be identified.  Several training samples can be 
selected and combined to make a single class.  The skill and knowledge of the 
analyst are important to the success of a supervised classification.  Once the 
training samples are gathered, there are a number of statistical classifiers that 
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can be used to process the image data.  ArcGIS 10 has Interactive Supervised 
Classification, Maximum Likelihood Classification, and Class Probability options 
for supervised classification.  As a final note, there are feature extraction tools for 
image analysis that will automatically use both spectral and spatial signatures to 
identify features in an image, also known as object-oriented classification, but 
they are not included in IA for ArcGIS 10. 
 
Unsupervised classification uses clustering routines to create the number of pixel 
classes designated by the analyst.  It is the responsibility of the analyst to assign 
meaningful identities to the classes after processing.  A typical procedure would 
be for the analyst to specify a large number of classes and then refine and group 
them to produce features such as areas of land cover types.  The unsupervised 
classification option in ArcGIS10 is the Iso Cluster Unsupervised Classification 
also known as ISODATA (Iterative Self-Organized Data Analysis Techniques A).  
Unsupervised classifications usually do not have unclassified pixels if the 
parameters are set correctly. 
 
It is common practice to combine both types of classification by performing an 
unsupervised classification prior to a supervised classification.  The unsupervised 
classification provides insight into the size and distribution of classes in the 
image and can guide the user in selecting better training samples. 
 
You should always evaluate the results of your classification to be sure the 
classification functions performed as you expected.  In many analyses, you will 
be expected to quantify the accuracy of your classification by comparison with 
various methods of ground truth.  Tabular presentation of the accuracy 
assessment is called an error matrix (also contingency table or confusion matrix).    
 
Please see Resource Center>Professional Library>Extensions >Spatial 
Analyst>Image classification and sub-topic >The Image Classification toolbar for 
detailed information on image classification.  The discussion of workflow in the 
“Image classification using Spatial Analyst” Help document is essential reading 
for understanding the classification process.   
 
Please refer to Remote Sensing and Image Interpretation by Lillesand, Kiefer, 
and Chipman for an in-depth discussion of classification.  
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Image classification is accessed through the Image Classification toolbar and the 
Spatial Analyst Tools>Multivariate functions.    

6       7        8        9  

 

1 
 
2 
 
3 
 
4 
 
5 

You will initially work with the Image Classification toolbar which makes some of 
the Multivariate functions available.  Drop-down commands 1, 2, and 4 perform 
different types of supervised classification.  Command 1, Interactive Supervised 
Classification, uses the Maximum Likelihood Classification tool to automatically 
classify a layer selected in the layer list using at least two training samples from 
the Training Sample Manager.  Command 2, Maximum Likelihood Classification 
(MLC), performs a classification on an input image layer using a signature file.  
While MLC is generally considered a supervised classification technique, the 
MLC geoprocessing tool is also used to perform an unsupervised classification 
from a signature file (.gsg) generated by the Iso Cluster tool in the Spatial Analyst 
Tools>Multivariate functions.  Command 4, Class Probability, creates a multi-
band raster with one probability band created for each class represented in the 
input signature file.  The probability layer ranks each pixel on the probability that 
it belongs to that class.  Probability layers are particularly useful for identifying 
and resolving mixed pixel issues.  

Buttons 6 through 9 are used to acquire and manage training samples for 
supervised classification.  Button 6  opens the Training Sample Manager 
which is the control center for supervised classification.  

  

The buttons from left to right are the Clear training samples  button that 
empties the training sample class list.  The Load  button adds training 
classes from a shapefile saved by the Save  button.  The Merge and Split 
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buttons  are used to combine classes or to separate classes that have 
been combined.  If you think you want to split classes you have merged, it is 
easier to save a classification list, clear the training samples, and then load the 
original list.  The Delete  button removes a class.  The Up and Down  
buttons change the order of classes in the list.  The Reset class value  allows 
you to assign a new number to a class in the Value column.  The Histograms, 
Scatterplots, and Statistics  buttons are extremely useful in 
understanding your data by providing you with visual and tabular comparisons of 
your classes.  The examples below show the separation (or lack of it) in the 
classes from the HouAirport_TM.tif image.  You must select the classes for 
display from the list in the Training sample manager.  It is obvious from the 
histogram plot that the signatures for Classes 1 - 2 and 5 - 6 overlap in TM band 
4 but are better separated in band 3.  Separating these classes is important since 
Class 1 (yellow) is dry grass and Class 2 (bright green) is forest and classes 5 
and 6 are pavement and green grass, respectively. 
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You can see the statistical separation of the classes in the scatter plots as well.  
Note that the cross plot of bands 3 – 4 and 4 – 5 show good separation in the 
clusters.   

 

 
 

The statistics table for Class 1 also shows low covariance between Band 4 and 
most other Bands.  Lower covariance indicates better the separation of the 
classes. 

 

 

The far-right button   is the Create Signature File button.  The signature file 
contains the means and covariances of the spectral values of the training 
samples for the bands chosen for the analysis.  The table below is an example of 
the signature file output for one class. 
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As you can see, the Training Sample Manager is a key element in supervised 
classification.  Button 7  clears the Training Sample Manager list to begin a 
new supervised classification session.  Button 8  opens the Training 
Sample Drawing Tools.  These tools draw shapes that select areas on the image 

  

 

for training sets.  The draw polygon and the draw rectangle 
tools are generally the most useful.  Button 9  selects 
training samples in the display and highlights them in the list. 

This has been a long introduction but now you are ready to create a supervised 
classification.  This is a good time to remember to subset image extent and multi-
spectral bands as needed to achieve your desired results. 
 
Start ArcMap and add the Image Classification Toolbar.  Add the 
HouAirport_TM.tif image with the Add Data button by navigating to the 
IAtutorial directory and selecting the designated file.  The image will appear in 
the ArcMap table of contents.  HouAirport_TM.tif is the spatial subset you 
created using the Clip button in Exercise 3.  This is a small area for classification 
but it has adequate diversity of land cover.  [You are using a small area because 
these operations are computationally and memory intensive.  Some computers, 
such as a laptop on which this tutorial was tested, do not have enough resources 
to process large scenes in ArcGIS 10.  If you get unexpected results, such as 
fewer classes than you specified in an unsupervised classification, this is an 
indication of memory issues per Esri and my testing.]  You will now add 9 one  
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foot pixel resolution aerial photographs acquired in the winter of 2010 from the 
Aerials2010 directory in the IAtutorial directory.  Create a Group Layer for the 
aerials to make management easier.  Since this is a supervised classification, 
you want to select the most representative examples of the classes you want to 
make.  Higher resolution images of your area are one of the best ways to do this.  
You don’t need full coverage, just the areas that contain your training samples.  
You also need to take into consideration the dates of acquisition.  In this case, 
changes have occurred in many areas since 1999 but you want to carefully 
select areas that have not had significant change. 
 
You will now create several training samples from which you will generate the 
supervised classes.  For this exercise, you will create 5 classes from 6 training 
samples.  The classes of interest in the Landsat TM image are: 1) dry grass, 2) 
green grass, 3) impervious surfaces A, 4) impervious surfaces B, 5) and forest.  
Start with the dry grass training sample.  Airport personnel have confirmed that 
the land cover between and around runways is mostly dry grass and scrub.  You 
will see a large area of brownish-maroon at the NW end of the runway oriented 
NNW-SSE on the west side of the airport.  Zoom to that area.  Use a scale of 
about 1:4,000 and examine the TM and aerial images.   
 

 
 
Observe the characteristics of the area such as access roads, other 
infrastructure, and the mowing patterns.  The north half of the area looks 
reasonably consistent.  This makes the area a good candidate for a training 
sample.  You should also note the misregistration of Landsat and aerial images 
based on the positional shift of the E-W road on the north boundary.  Use the 
measurement tool to determine the offset.  Hint: use swipe or transparency to 
make the measurement easier.  Be sure the HouAirport_TM.tif is selected in the 
layer list.  Select area that looks like the one illustrated using the Draw Rectangle 
(Button 8 dropdown).  This is your Class 1, dry grass.  Now zoom out to about 
1:10,000 and pan to the NW to the forest patch.   
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Select a new class in the forest area similar to the one shown.  The new class 
will appear with hash marks indicating the class is selected.  Because the aerials 
 are newer (2010), part of the forested area 

has been cleared.  (If you were going to 
classify a 2010 TM image, the forested 
area could be used to train the more recent 
image.)  Now that you have two classes, 
you can use Interactive Supervised 
Classification to see a first approximation of 
the classes.  Do this but delete the result 
and select another forested area, Class 3.  
Now you will select two areas of impervious 
surface.  In the example, a parking lot with 
cars is Class 4 and building roofs are Class 
5.  The final Class (6) is green grass.  The 
best nearby example is the golf course east 
of training sample Class 5.   

 

You now have training 
samples for all the classes 
needed for the project.  
Assign colors to your 
classes, in the class list, 
that make them 
representative and easily 
identifiable.  Test your 
classes with the Interactive 
tool.  If you are satisfied, it 
is time to save your classes.  
Use the Training Sample 
Manager to save the 
classes as a shape file. 
See the example below. 

4 

6 5
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Open the shape file and choose “unique values” in the symbology tab and assign 
class colors.  Even if your classes look good and represent reasonable 
differences, you need to have only one forest class.  You will now use the Merge 
button to combine classes 2 and 3.  Select those 2 classes and click the button.  
Class 2 will now contain the combined signatures.  Be sure the 
HouAirport_TM.tif is selected.  This time, “Save” the classification as a shape 
file and as a signature file with the “Create Signature File” button.  Now you will 
do a supervised classification with the Maximum Likelihood Classification Drop-
down command.  Be sure that HouAirport_TM.tif is selected.  Input the 
signature file you just created.  Specify a file name for the Output classified 
raster.  Use the default settings at this time.  The main drawback with the default 
 

  
 
settings is that the “Reject fraction” is set to 0,0 which means that every cell is 
classified.  This does not yield the best results because your original classes did 
not include all land cover types.  There should be some unclassified cells.   
 
At this time there is a “bug” with this option that has been reported to Esri.  
Even with a high Reject fraction (.99), all cells are classified.   
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Your results should look something like the example below. 
 

 
 
The final operation that needs to be considered is the cleaning or generalization 
of the data.  Notice that there are many instances of isolated or very small 
clusters of pixels.  If you were to use this classification to detect change, you 
would have a lot of “noise” in your analysis.  Reducing the noise requires the 
application of one or more smoothing or generalization techniques that include 
filtering with the Majority Filter, smoothing class boundaries with the Boundary 
Clean tool, and removing isolated regions with the Region Group tool and the 
Nibble tool.  Remember to review Resource Center>Professional Library> 
Extensions >Spatial Analyst>Image classification and sub-topic >The Image 
Classification toolbar for detailed information on this process.  The discussion of 
workflow in the “Image classification using Spatial Analyst” Help document is 
essential reading for understanding the classification and cleanup process. 
 
The technique we will use for this part of the exercise is the Majority Filter.  Zoom 
into the area marked by the red box above.  Hint: create a bookmark so you can 
easily return to the area.  Open ArcToolbox and scroll to the Spatial Analyst 
Tools.  Expand the Generalization tools and click on the Majority Filter. 
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Specify the file name you gave to the 
results of your Maximum Likelihood 
classification.  The majority filter has 
several options and you should 
experiment to determine the best 
setting for your data set and the 
desired result.  The Number of 
neighbors to use sets the array of 
cells.  “Four” uses a kernel of four 
orthogonal neighboring cells.  “Eight” 
uses a full 3x3 cell kernel.  The 
Replacement threshold specifies the 
number of spatially connected cells 
that must be the same value before 

 

 
replacement occurs.  Selecting “Majority” specifies that 3 of 4 or 5 of 8 connected 
cells must have the same value.  Selecting “Half” specifies that 2 of 4 or 4 of 8 
connected cells must have the same value and this option produces a smoother 
result.  You can also apply the filter multiple times to increase the smoothing 
effect.  Proceed carefully.  At some point you will begin to loose important data.  
Perform the Majority filter four times using different combinations of the basic 
options.  Give your output files names that will allow you to track the options you 
used per the examples below.  Prepare a map layout showing the unfiltered 
classification and your selection of the best result.  Add the layout to a Word 
document discussing the process you used to create the final classification.  
Please be detailed in your description of your filter choices.  What compromises 
resulted from your filter choices?  How would the compromises affect the use of 
the classification?  The effects of the Majority filter on cell counts can be viewed 
by selecting the layer and opening the Layer Properties>Symbology tab.  The 
examples below show the reduction in cell counts for smaller classes and the 
increase in cell counts for the larger classes. 
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Unfiltered classification 

 
Majority 4h filter 
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Unfiltered 

 
4m      8m 

 
4h      8h 
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Save your project for use with the next part of the Exercise. 

As a final step, compare your results with the 2001 National Land Cover 
Database using the raster IAtutorial \LandCoverDifference\NLCD2001 
\42103986.tif.  There will be significant differences because of the greater 
number of classes used in the NLCD product (top) and the date of analysis but 
you should see a lot of similarity as well. 
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Drop-down Command 3, the Iso Cluster Unsupervised Classification, is the only 
unsupervised classification tool in the Image Classification toolbar.  It differs from 
the Iso Cluster tool in the Spatial Analyst Tools in that it creates an output 
classified image as well as a signature file.  This command, however, does not 
offer control over the number of iterations used to define the clusters that is found 
in the Iso Cluster tool in the Spatial Analyst Tools>Multivariate functions shown 
below. 

 
You will now perform an unsupervised classification on the HouAirport_TM.tif 
image.  Use the map document (.MXD) that you saved from the supervised 
classification.  Clean the table of contents so that you only retain your base 
images and aerials, your unfiltered classification, and your best filtered result.  
From the Classification toolbar, select the Iso Cluster Unsupervised Classification 
drop-down (3).  Input the HouAirport_TM.tif as the raster band.  Specify the 
Number of classes as 24, name an output classified raster file, a Minimum class 
size (default, 20), a Sample interval of 2, and an Output signature file for future 
use.  Your window should look like the example below.  You changed the default 
Sample interval to 2 because, as mentioned before, some computers have 
insufficient memory to handle a bigger interval and will return fewer classes than 
specified.   
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The result should look something like the example below.   
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Compare the unsupervised classification with the supervised classification you 
did earlier, the NLCD product, and the airport aerials and TM image.  The 
unsupervised image looks noisy but it contains a lot of valuable information.   

As the analyst, it is now your job to make a useful classification from the 
unsupervised classes.  Your assignment is to develop a set of classes that 
represent major groups of land cover.  Go to the USGS MRLC site and examine 
the classification scheme that they have used that is based on the Anderson 
scheme www.mrlc.gov/changeproduct.php.  This chart also attempts to reconcile 
the classes used for NLCD 1992 and NLCD 2001. 

 
You will begin by assigning real identities to the classes that were created.  Use 
the TM image, aerials, and the NLCD product to help guide your interpretation.  A 
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good approach to this is to use your unsupervised classification as the top layer 
and “Swipe” it over the other layers.  An improvement on the plain “swipe” is to 

 
open the classification table and select a class in the unsupervised classification 
image.  This highlights a single class and now it can be compared with the 
underlying images and classifications.  As you see in the example, going 

 
to a gray scale allows the selected class to be highlighted without visual clutter.  
Use the “Identify” tool to view the class values in the underlying layers.  Another 
way to improve your efficiency and workflow is to export the classification table, 
place it in an Excel spreadsheet, and record your observations and correlations 
in the spreadsheet.  Open the classification table and go to the drop down menu. 
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Select the “Export” option and save the table to the geodatabase with an 
appropriate file name.   

 
Export the file using ArcCatalog to a .dbf file and open it in an Excel spreadsheet.  
You can also export directly to a .dbf by specifying it in the “Save as type” box.  
Below is an example of a spreadsheet created by the method outlined. 
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You can see from the spreadsheet that, as expected, there are multiple classes 
within the major land cover classes.  For the purposes of this exercise, you only 
need the major classes.  Merging some classes that have obvious relationships 
is needed.  Classes 1 through 5, 8, and 9 in this example all appear to be forest.  
Classes can be reassigned using the “Reclassify” tool.   
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Use the spreadsheet to assign new 
classes to the layer.  Open the 
“Reclassify” tool by going to 
ArcToolbox>Spatial Analyst Tools> 
Reclass>Reclassify.  This will open the 
“Reclassify” menu seen below.  The 
input is the houairu24c layer in this 
case.  If the classes do not appear, be 
sure the Reclass field is “Value” and 
click the “Unique” button.  Enter the 
new class designations in the “New 
values” boxes.  Save the completed 
reclassification to an appropriate file 
name.  For continuity, ReclsHouair1 
was used for this example. 
 
Add the reclassified image to the Table 
of Contents and set the symbology to 
display the new classes.  Your results 
should look something like the screen 
capture below.  Examine the 
ReclsHouair1 layer table to see the 
numerical distribution of class pixels. 
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You might want to remove some of the noisy pixels with the appropriate 
generalizing procedure (Majority filter) as you did in the supervised classification 
section of the exercise. 
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Use your skills and the tools you have explored to create a map that represents 
the major land cover types in this area.  Place the map in a Word document with 
an explanation of your process and the results.  Discuss the differences you 
observe between the NLCD layer and your classification. 

Turn in all the documents requested for Exercise 4 credit. 
 
This concludes the Exercise 4.  However, we did not yet discuss or use 
Command 5, Principal Components.  Here is a brief description to complete the 
Command discussion.  Principal Components is an analysis that is not really a 
classification.  Principal Components analysis transforms a multi-band image to 
minimize band correlation.  This geoprocessing tool creates a new image with 
the information compressed into fewer bands or components.  The first 
component represents the greatest variance, usually brightness.  The second 
component represents the second greatest variance in the remaining image 
information.  The content of the remaining components depends upon the image 
characteristics.  According to Aronoff, “Typically, over 90% of the variability in 
pixel values in an image is captured in the first two or three components”.  
Components beyond 5 are usually image noise.  By enhancing the first few 
bands of a principal components image, you can produce an image layer that 
might be helpful in identifying training sets. 
 
You have now completed an introduction to the basics of image analysis in 
ArcGIS 10.  A supplementary Exercise on georeferencing photographs is 
planned for the near future.  However, you now have the knowledge and tools to 
add imagery and information derived from imagery to your GIS projects.  Good 
luck! 
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Optional Exercise 1 – Temporal Comparison 
 
In Exercise 3, you prepared a band composite for a Landsat scene from January 
of 2003.  You have worked extensively with the image from September of 1999.  
The time period between images was characterized by active development in the 
Houston area.  There were also differences in precipitation between the two 
years.  In this Exercise, you will process the 2003 image and compare the results 
with the 1999 image.   
 
Start ArcMap.  Add the Houston_TM250.tif layer and the Hou03_4B layer to 
the Table of Contents.  Subset the Hou03_4B layer to the same extent as the 
Houston_TM250.tif and name it Hou03_4_TM250.  Using a 4,3,2 band 
combination for both images, apply a 2 Standard Deviation stretch and Gamma 
stretch to both.  Your results should resemble the examples below. 
 
9/1999 
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1/2003 
 

 
 
Carefully examine the results and make notes on the significant differences.   
 
The NDVI transform does a good job of highlighting the conversion of areas of 
tree canopy and grassland to urban uses.  Perform an NDVI transform on the 
Hou03_4_TM250 image.  Add the NDVI_Houston_TM250.tif image to the Table 
of Contents.  Compare the NDVI results on both images.  Be sure to examine the 
properties of the default colormap that ArcGIS applies to this product.  Are they 
identical?  Your results should resemble the examples below. 
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1/2003 

 
9/1999 
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As the analyst and interpreter, you now have a lot of things to consider.  Here are 
some points to help you with your analysis. 
 
What would you expect of the vegetation conditions considering the times of year 
that the images were acquired?  Can you compare the images directly and would 
a Difference function be appropriate? 
 
Examine the bodies of water in the two scenes.  What do they tell you about 
precipitation conditions?  Apply that knowledge to your interpretation of the NDVI 
results. 
 
The 4,3,2 band combination has a distinct signature for golf courses in both 
images.  Use that signature to help you examine the NDVI signatures for those 
features.  Are these results consistent with your conclusions regarding 
precipitation? 
 
You might be able to extract an urban class from the NDVI.  What functions 
would you use to accomplish that operation?  Is there an NDVI value below 
which most urban features fall?  We have already discussed masks in relation to 
extracting an urban class based on NDVI but for thoroughness, what types of 
features need to be masked out to produce a “clean” urban class? 
 
Prepare a brief, professional report discussing the losses or gains in vegetation 
and urban land cover that you have observed between the two images.  Be as 
quantitative as you can in your comparison.  Be thorough in your evaluation of 
the limitations of the analysis.  Include a discussion of the choice of bands and 
the observed signatures of land cover elements.  Use maps and tables to 
illustrate your conclusions.  The report will be written in Word (compatibility) 
format. 
 


